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Section 2 
 

Formatting Forms 

By the end of this Section you should be able to: 

Insert Pictures as Backgrounds 
Insert a Chart 

Use Page Headers and Footers 
Understand Conditional Formatting 

Use Date and Time Fields 
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Exercise 12 - Adding Backgrounds 
Guidelines: 

Backgrounds images can be added to forms or reports. The background needs 
to be in a picture format, e.g .jpg, .bmp, .ico, .dib, .wmf or .emf file, which can 
be embedded or linked. An embedded background is stored as part of each 
database object in which it appears. A linked background is stored once, so 
utilising storage space more efficiently. Another advantage of linking is that if 
the original linked background image is altered, e.g. a corporate logo change, 
this would automatically be seen in all database objects using this background. 

Actions: 

1. Open the Wine database and the Products Form in Design View. 

2. Double click the Form Selector to open the Property Sheet for the form. 

 
3. From the Format tab in the Property Sheet, scroll down and select the 

Picture property. Click the Build button.  

4. From the Insert Picture dialog box, locate the Grapepicking file (this is a 
.jpg file supplied with the data for this guide). Select the file and click OK. 

5. From the Property Sheet, choose a Picture Type of Embedded and a 
Picture Size Mode of Stretch. Switch to Form View. 

6. The image fills the available space. Reduce the size of the Access 
window. The image changes to match the size of the window. 

 
continued over 

Form Selector Button 
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Exercise 12 - Continued 
7. Notice that by default the data labels are transparent (the background can 

be seen through them) but the data fields are not. 

Note: Sometimes a background image can mask the displayed data and it may 
be advisable to use only light images for this purpose. 

8. Maximise the window and switch back to Design View. Change the Form 
properties to Picture Size Mode = Clip, Picture Alignment = Top Left 
and Picture Tiling = Yes. 

9. Switch to Form View to see the changed effect, then close the form 
without saving. 

10. Picture backgrounds can also be added to reports. Open the Products 
report in Design View and click on the Report Selector. A warning tag 
may be shown. 

 
11. If the tag is shown, click it and select Remove Extra Report Space. 

12. Display the Property Sheet and select a Picture Size Mode of Stretch 
and a Picture Type of Linked. 

13. Click the Build button in the Picture property, locate the Champagne file 
from the supplied data folder and click Open. 

Note: A linked image does not become part of the object, but the original source 
image file must be always be available. 

14. Switch to Print Preview to see the effect. Notice the background image is 
seen on every report page. 

15. Save the report and close it. 

16. The background image is linked, so a change to the original picture will be 
seen in the form. Start the Windows Paint application. This can be found 
by clicking the Start button, selecting All Programs and opening the 
Accessories folder. 

Note: Any image processing application can be used. 

17. Open the Champagne image and change the fill colour to pale yellow. 
Save the image, close it and close Paint. 

18. In the Access window open the Products report. The background image 
will show the changed image. 

19. Close the report without saving but leave the database open. 
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Exercise 13 - Inserting a Picture 
Guidelines: 

Objects such as pictures can also be added to the foreground of forms or 
reports either embedded or as linked objects. Objects can be pictures, images, 
media clips, charts or files from other applications, e.g. Excel. If an object is 
embedded, it will not change after insertion. If it is linked, it will change 
automatically as the source object changes, such as in a chart (covered later in 
this section). 

Actions: 

1. From the Wine database, open the Orders Form in Design View. If the 
Security Warning is displayed, select Enable content. 

2. Display the Property Sheet for the Add Record button. 

3. From the Format tab, click in the Picture property and select the Build 
button. The Picture Builder dialog box appears. 

 

4. There are a number of icons available with Access that can be added to a 
button. Select some of the available pictures and observe the effect in the 
Sample area. 

5. Alternatively, pictures can be selected from any source. Click on Browse 
to display the Select Picture dialog box. Locate the folder containing the 
supplied data files and select the Carafe picture. 

6. Click Open. 

7. Click OK on the Picture Builder dialog box. The image is added to the 
button. Extend the height of the button to see more of the image. 

8. Save the form and switch to Form View. The picture does not affect the 
operation of the button. Click on the button to go to a new record form. 
Content will have to be enabled for this action to work. 

continued over 
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Exercise 13 - Continued 
9. Close the Orders Form and open the Products Form in Design View. 

10. Pictures can be inserted directly on to a form and not just on to a button. 
Increase the height of the Detail area, click Insert Image on the Design 
tab then select Browse. 

11. The Insert Picture dialog box is displayed, but by default only shows 
Web-Ready Image Files. Use the drop down arrow to change this to All 
Files. Make sure the contents of the supplied data folder are displayed 
and select the Bottle picture file. Click OK. 

12. Draw 4cm square with the picture frame cursor, . The image will be 
inserted automatically. 

Note: To insert a clip art image, locate the folder containing the clips, e.g. 
Program Files | Microsoft Office | ClipArt | PUB60COR, and select an 
image from the list. 

13. Make sure the Property Sheet for the image is displayed and set the Size 
Mode to Stretch. 

Note: If a picture is to be linked and not embedded, the Picture Type property 
would be changed to Linked. 

14. Click and drag a corner of the image frame to make it larger. 

15. Save the form then switch to Form View.  

 

16. Switch to Design View, click on the picture to select it and press 
<Delete>. The picture is removed. 

17. Close the form without saving and close the database. 
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Exercise 14 - Inserting a Chart 
Guidelines: 

Data can be displayed in a chart within a form or report. The chart wizard is 
usually used to create a chart. 

Actions: 

1. Open the Egypt database and open the Summary form in Design View. 
Make sure the Design tab is displayed. 

2. In the Controls group, make sure the Use Control Wizards button is on, 

then click the Chart button from the same group, . 

3. Click in the form Detail area below the Adults field. The Chart Wizard 
appears. In the first screen, select the Bookings table and click Next. 

4. Move the Adults and Airport fields from the Available Fields box into 
the Fields for Chart box. Click Next. 

5. Click on the 3-D Column Chart to select it and click Next. 

 
Note: The sample chart may not be displayed. 

6. This screen shows how the data will be used in the report. Click Next. 

7. This screen allows the chart to be linked to the individual record displayed 
on the form, but for this exercise delete both field names so that the chart 
contains data from all records. Click Next. 

8. Enter a title of All Data, click the option No, don’t display a legend, then 
click Finish. A chart is displayed with sample (not actual) data. 

continued over 
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Exercise 14 - Continued 
9. Drag the borders of the chart to make it 15cm wide by 6cm high. Increase 

the size of the Detail area if necessary. 

10. Switch to Form View. The sample data will be replaced with the actual 
data. Switch back to Design View. 

11. Double click on the chart to open it in edit mode. This mode is indicated 
by a diagonally shaded border around the chart. 

Note: If the Datasheet box appears when you double click, close it. 

12. Right click on a blank (white) area of the chart and select the option 
Format Chart Area from the shortcut menu. 

Note: If Format Chart Area is not an option, you have probably clicked in the 
wrong area. Try again.  

13. The Format Chart Area dialog box is displayed. Change the Font to 
Arial, Italic and size 10pt. Click OK. All text on the chart is changed. 

14. Right click on the chart title and select Format Chart Title. Change the 
font to Arial, Bold, 14pt and click OK. 

15. Right click on the (grey) background to the chart and select Format 
Walls. Apply the palest green colour to the background area. 

16. There is another way to format chart features. Double click on one of the 
data columns to display the Format Data Series dialog box. 

17. Change the colour to red and click OK. All columns for this data series are 
changed. 

18. Click anywhere away from the chart to deselect it then switch to Form 
View. If the chart is not shown, click in the white area where it should be. 

 

19. Use the Navigation buttons to scroll through the records on the form. The 
chart will not change. 

20. Close the form, saving the changes, then close the database. 
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Exercise 15 - Page Headers and Footers 
Guidelines: 

In forms, Page Headers and Footers are similar to Form Headers and 
Footers - they can display titles, dates, etc. on every page, but they only 
appear when the form is printed. They cannot be seen in Form View. 

Actions: 

1. From the Wine database, open the Orders Form in Design View. The 
form has a Form Header (empty) and a Form Footer.  

2. Expand the Form Header area, place a Label in the centre and enter the 
text Form header goes here. Increase the font size to 12pt. 

3. Right click on the Form Header bar and move the cursor over Fill/Back 
Color from the shortcut menu. Select a pale blue colour. 

4. Right click on the Form Header bar again and select Page 
Header/Footer, from the shortcut menu. The form now has two new 
areas, a Page Header area above the Detail and a Page Footer area 
below the Detail. 

5. Place a Label in the Page Header, and enter the text Page header goes 
here. Increase the font size to 12pt. 

6. Right click on the Page Header bar and move the cursor over Fill/Back 
Color from the shortcut menu. Select a yellow colour. 

 

7. Save the form and switch to Form View. Only the blue Form Header is 
shown. Move through the records, the header is on every form. 

8. Click the File tab, select Print and click Print Preview from the options. 
On the first page the blue Form Header and yellow Page Header are 
shown. On all other pages, only the yellow Page Header is shown. 

9. Close Print Preview and close the form, but leave the database open. 



Open Learning  Access Advanced 

 
© CiA Training Ltd 2011 33 Access 2010 

Exercise 16 - Conditional Formatting 
Guidelines: 

If a control (text box, command button, check box) which is placed on a form or 
report contains a value that needs to be monitored, Conditional Formatting 
can be applied. This will make the value easier to spot if a certain condition 
applies, e.g. a sales target dropping below a certain figure. Controls can be 
given different coloured backgrounds, or text can be set up to disable the 
control when it meets or doesn’t meet certain criteria. 

Actions: 

1. From the Wine database, open Products Form in Design View. Display 
the Form Design Tools - Format tab. 

2. Click on the Stock field then select the Conditional 
Formatting button. Click New Rule to display the New 
Formatting Rule dialog box. 

3. Change the rule description to read Field Value Is less than or equal to 
200. 

4. To define the formatting when the condition is met, click the Font Color 
button and select red, then click the Background color button and select 
yellow. Finally click the Bold button. The formatting effect is previewed. 

 
5. Click OK then OK again. Save the form and switch to Form View. 

6. Scroll through the records and notice that any stock quantity less than or 
equal to 200, will be immediately conspicuous. 

7. Move to the record 4 for Soave. Increase the quantity to 300. Click in a 
different field. The conditional formatting no longer applies. 

8. Leave the form open for the next exercise. 
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Exercise 17 - Insert Date and Time 
Guidelines: 

The current date and time can be placed on a form or report as a text box. By 
default, Access will place the text box into the header section but it can then be 
moved or entered manually. The format of the date and time can be varied. 

Actions: 

1. The Products Form should be open. Switch to Design View. 

2. Click the Date and Time button, , in the Header/Footer group of the 
Design tab. The Date and Time dialog box appears. 

3. Click on the first date format option and uncheck the Include Time box to 
deselect the time option. 

 

4. Click OK. The date field appears in the Form Header. 

5. Use the Text Box button to add a text box to the right of the image in the 
Detail area (widen the area if necessary). Enter a field value of =Date() 
and a label of Current Date. Display the Property Sheet and set the 
Format to Long Date. 

6. Add a field below this with a value of =Time() a label of Current Time. On 
the Property Sheet set the Format to Long Time. Save the form and 
switch to Form View. The time and date will appear for every record. 

 

7. Use the navigation buttons to move through the records. Note that each 
time the form is redisplayed, the time is updated. 

8. Close the form without saving but leave the database open. 
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Exercise 18 - Revision: Formatting Forms 
1. Use the Wine database. 

2. Add an Embedded background to the Orders Form, using the 
Champagne picture supplied on the data disk. 

3. Apply a Picture Size Mode of Stretch. 

4. Add a Page Footer area to the form and insert a label with the text 
Orders. 

5. Save the form, then print preview it. 

6. Apply Conditional Formatting to the Quantity field, so that if 24 or more 
items are ordered, the field background becomes blue. 

7. Insert the Date and Time and move them to the bottom of the Page 
Footer on the form. 

8. View the form in Form View, checking the Quantity field conditional 
formatting works. 

9. Are the Date and Time fields visible in Form View? 

10. Print Preview the form. Are the Date and Time fields visible now? 

11. Explain the difference in views. 

12. Save and close the form, then close the database. 

Note: The answers to this exercise can be found in the Answers Section at the 
end of the guide. 


